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EXECUTIVE SUMMARY 
 
 

Irrigation Water Requirement Estimation Decision Support System (IWREDSS) is an ArcGIS-

based numerical simulation model developed as part of the Water Management Software to 

Estimate Crop Irrigation Requirements for Consumptive Use Permitting in Hawaii project. The 

model calculates irrigation requirements (IRR) for different crops grown under Hawaiian 

conditions. In addition to IRR, IWREDSS calculates other water budget components including 

net irrigation water requirements (NIR), gross irrigation water requirements (GIR), water duty in 

1000 gallons per acre (GAL_A), gross rain (G_RAIN), net rain (N_RAIN), effective rain (ER), 

runoff (RO), canopy interception (INT), potential evapotranspiration (ETO), reference 

evapotranspiration (ETC), and drainage (DR). IWREDSS calculates GIR for different irrigation 

application systems; trickle-drip, trickle-spray, multi sprinkler, nursery/container sprinkler, large 

gun sprinkler, seepage/sub irrigation, crown flood, and flood (Taro), growing seasons and 

irrigation practices; irrigate to field capacity (usual practice), apply a fixed water rate per 

irrigation, deficit or rainfed. IWREDSS takes in account the effect of water table on IRR 

calculations through the depth to water table option; its default value was set to 50 ft. 

 IWREDSS uses long-term weather, crop parameters, and soil physical properties 

databases. These databases and other input parameters used by IWREDSS are summarized in 

this report and include 1) pan evaporation/potential evapotranspiration, total and effective 

rainfall from National Oceanographic and Atmospheric Administration (NOAA) cooperative 

observer stations, 2) NOAA climate stations, 3) aquifer system maps, 4) soil water holding 

capacities based on USDA-NRCS soil survey, and 5) crop water management parameters 

including (a) length of growing season, (b) crop coefficient, (c) evapotranspiration, and (d) 

effective rooting depth of various crops.  

IWREDSS runs as an extension of the ESRI ArcGIS 9.2 software. The user’s manual of 

IWREDSS provides step by step instructions on how to use IWREDSS for various scenarios 

which include 1) Island-wide simulation using Agricultural Lands of Importance to the State of 

Hawaii (ALISH), 2) Island-wide simulation using Land Study Bureau Classification (LSB), 3) 

particular area simulation using Tax_ID from a TMK, and 4) simulation of a user’s provided GIS 

layer (digitized information). IWREDSS outputs can be retrieved in form of text (ASCII) files 
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and visualized in ArcMap. 

IWRDESS was calibrated and validated based on crop water requirement for different 

crops using the Hawaii USDA-NRCS Handbook 38 (USDA-NRCS, 1996). A sensitivity analysis 

was also carried out to test the effect of the timing of the growing seasons on IRR for Seed Corn. 

During this analysis, we used twelve different growing seasons that were rotated between 

January and December, i.e., the first growing season was January 1 to April 30 and the twelfths 

growing season was between December 1 of the year one and March 30 of the year 2. 

Estimations of IRR were also calculated for different bioenergy crops for windward and leeward 

conditions on the islands of Maui, Kauai, Oahu and Hawaii. Results of the analysis showed that 

IWREDSS is a practical tool that can be used to assess irrigation requirements for a variety of 

potential and specific crops of Hawaiian Islands. IWREDSS model estimates were in close 

agreement with those estimated by USDA-NRCS Handbook 38. 
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GLOSSARY:  

• ALISH: Agricultural Lands of Importance to the State of Hawaii.  
• AWD (Allowable Water Depletion): Fraction of the available soil water storage capacity that 

can be allowed to deplete without significant reduction in crop yield. 
• DR (Drainage): Portion of incoming water that drains below plant root zone. 
• ER (Effective Rain): Portion of water that is stored in the root zone and used by the plants. 
• ETC (Reference Evapotranspiration): Portion of water that vaporizes back to the atmosphere 

via plants. The ETC is the amount of ETO occurring from a specific crop. 
• ETO (Potential Evapotranspiration): Evapotranspiration to the given atmospheric conditions. 
• G_RAIN (Gross Rain): The rain that falls from the clouds and reaches the crown of plants.  
• GAL_A: Water duty in inches of 1000 gallons per acre.  
• GIR (Gross Irrigation Requirements): NIR divided by the application efficiency of irrigation 

application system. 
• GIS: Geographic information system. 
• INT (Canopy Interception): Portion of G_RAIN intercepted by the plant canopy or crown. 
• IWREDSS: Irrigation Water Requirement Estimation Decision Support System. 
• IRR: Irrigation requirements 
• KC: Crop coefficient. 
• LAI (Leaf Area Index): Ratio of total upper leaf surface of vegetation divided by the surface 

area of the land on which the vegetation grows. 
• LSB: Island-wide simulation using Land Study Bureau Classification. 
• N_RAIN (Net Rain): The volume of rainfall that reaches the soil and comprises throughfall 

and stemflow. 
• NIR (Net Irrigation Requirements): Irrigation requirements estimated by model without 

accounting for irrigation losses. 
• PE: Open pan evaporation 
• RO (Runoff): Portion of incoming water that runs off to the low level areas. 
• SCS CN (Soil Conservation Services Curve Number): It is related to the imperviousness of a 

surface; for impervious and water surfaces CN=100, for natural surfaces CN < 100. 
 
 

1. INTRODUCTION 

Irrigation Water Requirement Estimation Decision Support System, IWREDSS, was developed 

as part of the Water Management Software to Estimate Crop Irrigation Requirements for 

Consumptive Use Permitting in Hawaii project. IWREDSS allows users to estimate irrigation 

requirements for different crops, soils, irrigation systems, growing seasons, and climate 

conditions. The irrigation requirement of a crop is the amount of water required by the crop, in 

addition to precipitation, to meet its water demand resulting from evapotranspiration (ET). The 

irrigation requirements do not account for excess water losses due to poor irrigation 
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management, leaching, and water applied for freeze protection, or crop cooling requirements, 

even though water for these purposes may be applied through an irrigation system. 

IWREDSS is an ArcGIS based software with a user-friendly interface. There are two 

ways that the user can follow to select the area for which irrigation requirements, IRR, are 

calculated. First, the user can use the Tax-ID GIS layer. The second option would be to use a 

georeferenced map of the area. In this document, we have details on how to digitize a hard copy 

of the area of interest. After choosing the area of interest, the user continues entering the input 

parameters. This includes crop to be grown/irrigated, crop leaf area index (LAI), the growing 

season, irrigation system to be used, appropriate curve number, and water table depth. In addition 

to these user selected data, IWREDSS uses the corresponding weather and soil data from its 

Geodatabases. Based on the coordinates of the location and the closest climate station, 

IWREDSS interpolates the appropriate rainfall and evapotranspiration for the area of interest that 

is used for IRR calculations. On successful execution, the users are given the option to retrieve 

and visualize the results in the form of a text (ASCII) file and a GIS map. 

Recent developments in geographical information systems (GIS) present the opportunity 

to apply physically based soil water balance and simulation models at a regional scale (Satti et al, 

2004). Satti and Jacobs (2004) developed GWRAPPS (GIS-based Water Resources and 

Agricultural Permitting and Planning System) model by coupling the AFSIRS model with GIS.  

Several models including CropSyst (Stockle et al., 1994), AEGIS/WIN (Engel et al., 1997), and 

GWRAPPS are able to simulate the soil water budget components (WBC) by coupling crop and 

soil parameters with long-term climate databases. 

This report covers the following deliverables. 

• Databases of the IWREDSS elements and parameters 
• GIS island maps showing climate stations used to develop the rainfall and ET databases.  
• A DVD containing tested version of IWREDSS 
• Results of IWREDSS calibration and validation 
• Results of IWREDSS sensitivity analysis 
• Testing of IWREDSS using energy crops 
• IWREDSS user manual 
• IWREDSS technical guide 

The user’s manual and the technical guide for IWREDSS are two separate documentations and 
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are attached with this report as appendices 1 and 2, respectively. 

2. REVIEW OF LITERATURE 

Technical Release 21 method developed by the Soil Conservation Service (SCS, 1970), 

estimates monthly IRR based on monthly average rainfall and ET, and on soil water-holding 

capacity. However, IWREDSS model integrates the effects of day-to-day distributions of 

rainfall, ET, and soil water-holding capacity to calculate IRR.  

Since the 1980’s, the regional water management districts of Florida have been using this 

daily water budget approach. Melaika and Bottcher (1988) applied this approach to model 

nutrient movement from a South Florida watershed in the Everglades Agricultural Area. 

Villalobos and Fereres (1989) developed a water budget model based on long-term average 

potential ET and actual rainfall data. In their model, potential ET was assumed to be constant 

each year because long-term data were not available. Water budget approach is used to develop a 

crop yield model, and weather data are simulated if long-term climate data were not available. 

Smajstrla and Zazueta (1987) demonstrated the data requirements and sensitivity of the water 

budget approach to determine irrigation requirements of Florida nursery and agronomic crops. 

Water budget models have been developed for different crops. Brown et al. (1978), 

Odhiambo and Murty (1996), and Mishra (1999) studied the water balance of rice. Pereira (1989) 

developed the rice water balance model IRRICEP and tested its performance against field data. 

Smith (1991) developed a simulation model, CROPWAT, that also uses water balance approach. 

Paulo et al. (1995) validated IRRICEP using historical data on water use for selected sectors of 

Sorraia irrigation system in Brazil. Shah and Edling (2000) used the water balance approach to 

determine daily evapotranspiration from a flooded rice field based on measured values of water 

level, precipitation, irrigation, seepage, and tail water runoff. Khepar et al. (2000) developed a 

water balance model applicable to intermittent irrigation practice in rice fields by incorporating 

saturated and unsaturated water flow concepts to predict deep percolation losses during wet and 

dry periods.  

Many water budget models lack user-friendly interface and offer limited flexibility in 

selecting a suitable method for estimating potential evapotranspiration. There had been some 

efforts to couple user-friendly interfaces with GIS for efficient and quick data handling. Knox et 
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al. (1996, 1997) developed a procedure for mapping the spatial distribution of irrigation water 

requirements for a main crop (potato) by taking into account crop, climate and soil factors in 

England and Wales. George et al. (2000) developed a user-friendly irrigation scheduling model, 

ISM, for field crops. Weatherhead and Knox (2000) developed a methodology for predicting the 

future growth in irrigation demand in countries with supplemental irrigation such as England and 

Wales using GIS. The GIS based water- and salt-balance studies at irrigation district level have 

also been attempted (Young and Wallender, 2002). George et al. (2004) used GIS as a helping 

tool to handle spatial and extensive input information for their irrigation scheduling model. 

IWREDSS calculates IRR on a weekly, bi-weekly and monthly basis giving the user 

different options for periodical irrigation requirements. IWREDSS uses different databases to 

calculate IRR. 

3. DATABASES 

IWREDSS database includes historical daily potential evapotranspiration and rainfall for 

different locations across the major five Hawaiian Islands. The range of these two databases is 

variable across the different locations. In addition, there is the crop database that includes all 

crop coefficients and root development parameters. 

3.1 Crop Parameters 

The crop parameters including effective rooting depths, crop coefficients (Kc), duration of crop 

cycle, allowable water depletion for the listed annual (Table 1) and perennial (Table 2) crops. 

3.2 Irrigation System Efficiency 

Irrigation efficiencies of the preferred irrigation systems including sprinkler, micro-spray, and 

drip irrigation systems are listed in Tables 1 and 2. 

3.3 Climate Stations and Soils 

There are two full climate stations operating in Hawaii. 

(1) At HI Mauna Loa 5 NNE Mauna Loa Observation, NOAA Earth Systems Research 

Lab.,Global Monitoring Division, location: 19.5N  155.6W  11092’ (Fig. 1). 
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(2) At University of Hawaii Waiakea Experiment Station which is named HI Hilo 5 S, 

location: 19.6N  155.1W  730’ (Fig. 2).  

Rainfall and ET were measured (Appendix 3) at different stations across the major 

Hawaiian Islands. The stations include  Mana, Kekaha, Wahiawa, McBryde Station (ET), 

Bydswood Station (rain), Lihue Variety Station, Kunia Substation, Waimanalo Experiment 

Station, Kualapuu Reservoir (ET), Kualapuu (rain), Pohakea Bridge (Rain), Field 906 (ET), Kula 

Branch, Lalaumilo , Hamakua Makai Field Office, and Paauilo (Appendices 4a to 4d). Rain 

isohyets demonstrate high spatial variation in rainfall (dark contours) to a certain extent with 

elevation (light contours). Station information is provided in Table 3. Characteristics of Climate 

stations are given in Table 3. Texture and water holding capacity of the major soil types in 

Hawaii are presented in Table 4.  

3.4 Rainfall and Evapotranspiration 

The rainfall and ET data cover different periods i.e., period of 25 years (1980-2005) and 

accompany IWREDSS in shape of GIS layers and excel spreadsheets.  
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Table 1. Annual crop effective root depth, Kc values and stage lengths as a fraction of growing period  
Root depth 

(in) Duration (fraction of crop cycle) Allowable water depletion 
(fraction of total) Crop 

Initial Final 
Kcinitial Kcmid Kclate Stage 

1 
Stage 

2 
Stage 

3 
Stage 

4 
Stage 

1 
Stage 

2 
Stage 

3 
Stage 

4 

Irrigation 
type 

Irrigation 
efficiency 

(%) 

Alfalfa, initial 8 24 0.4 0.95 0.9 0.14 0.38 0.31 0.17 0.5 0.5 0.5 0.5 Sprinkler 70 
Alfalfa, ratoon 24 24 0.4 0.95 0.9 0.14 0.38 0.31 0.17 0.5 0.5 0.5 0.5 Sprinkler 70 
Bana Grass 
(Sudan), 1st cut 18 36 0.5 0.9 0.85 0.33 0.33 0.2 0.14 0.5 0.5 0.5 0.5 Sprinkler 70 

Bana Grass 
(Sudan), 2nd cut 36 36 0.5 1.15 1.1 0.08 0.4 0.32 0.19 0.5 0.5 0.5 0.5 Sprinkler 70 

Banana, initial 24 48 0.5 1.1 1 0.31 0.23 0.31 0.15 0.35 0.35 0.35 0.35 Micro-spray 80 

Banana, ratoon 48 48 1 1.05 1.05 0.33 0.16 0.49 0.01 0.35 0.35 0.35 0.35 Micro-spray 80 

Cabbage 8 12 0.7 1.05 0.95 0.24 0.36 0.3 0.09 0.45 0.45 0.45 0.45 Drip 85 

Cantaloupe 8 12 0.5 0.85 0.6 0.08 0.5 0.21 0.21 0.35 0.35 0.35 0.35 Drip 85 

Dry Onion 8 12 0.7 1.05 0.75 0.1 0.17 0.5 0.23 0.25 0.25 0.25 0.9 Drip 85 

Eggplant 8 12 0.7 1.05 0.9 0.21 0.32 0.29 0.18 0.4 0.4 0.4 0.4 Drip 85 
Ginger (AWD 
potatoes) 8 12 0.7 1.05 0.75 0.1 0.17 0.5 0.23 0.25 0.25 0.25 0.25 Drip 85 

Lettuce 8 12 0.7 1 0.95 0.2.7 0.4 0.2 0.13 0.3 0.3 0.3 0.3 Sprinkler 70 

Other melon 8 12 0.5 1.05 0.75 0.21 0.29 0.33 0.17 0.35 0.35 0.35 0.35 Drip 85 

Pineapple, year 1 12 12 0.5 0.3 0.3 0.16 0.33 0.26 0.25 0.6 0.6 0.6 0.6 Drip 85 

Pineapple, year 2 24 24 0.3 0.3 0.3 0.38 0.32 0.27 0.03 0.6 0.6 0.6 0.6 Drip 85 

Pumpkin 8 12 0.5 1 0.8 0.2 0.3 0.3 0.2 0.35 0.35 0.35 0.5 Drip 85 

Seed Corn 12 18 0.4 1.2 0.5 0.16 0.28 0.32 0.24 0.6 0.6 0.6 0.8 Drip 85 
Sugarcane, New- 
year 1 18 36 0.4 1.25 1.25 0.21 0.29 0.25 0.25 0.65 0.65 0.65 0.65 Drip 85 

Sugarcane, 
New- year 2 36 36 1.25 1.25 0.75 0.14 0.14 0.14 0.59 0.65 0.65 0.65 0.65 Drip 85 

Sugarcane, ratoon 36 36 0.4 1.25 0.75 0.1 0.15 0.46 0.29 0.65 0.65 0.65 0.65 Drip 85 

Sweet potato 8 12 0.5 1.15 0.65 0.12 0.24 0.4 0.24 0.65 0.65 0.65 0.65 Drip 85 

Taro 8 12 1.05 1.15 1.1 0.2 0.13 0.4 0.27 0 0 0 0 Flood 50 

Tomato 8 12 0.6 1.15 0.8 0.2 0.27 0.34 0.19 0.4 0.4 0.4 0.65 Drip 85 
Watermelon 8 12 0.4 1 0.75 0.15 0.26 0.26 0.32 0.26 0.32 0.26 0.32 Drip 85 
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Table 2.  Perennial crop effective root depth and KC values by month of the year 
Root depth (in) 

Crop 
Initial Final 

Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec Irrigation type Irrigation 
efficiency 

Coffee 24 48 0.85 0.85 0.85 0.9 0.95 0.95 0.95 0.95 0.95 0.95 0.9 0.9 Micro spray 
(MS) 0.8 

Dendrobium, pot 8 8 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 MS;  nursery 
sprinkler 0.80, 0.20 

Draceana, pot 8 8 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 MS;  nursery 
sprinkler 0.80, 0.20 

Eucalyptus closed 
canopy (old) 72 72 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 Micro spray 0.8 

Eucalyptus young 48 72 0.6 0.6 0.6 0.6 0.6 0.6 0.6 0.6 0.6 0.6 0.6 0.6 Micro spray 0.8 

Guava 30 60 8.0 0.9 1.0 1.0 9.0 0.8 0.8 0.9 1.0 1.0 9.0 8.5 Micro spray 0.8 

Heliconia 24 48 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 Micro spray 0.8 

Kikuyu grass 24 48 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 Sprinkler 0.75 

Leuceana (Old) 72 72 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 Micro spray 0.8 

Leuceana (Young 48 72 0.6 0.6 0.6 0.6 0.6 0.6 0.6 0.6 0.6 0.6 0.6 0.6 Micro spray 0.8 

Lychee 30 60 0.95 1.0 1.0 1.0 0.95 0.9 0.9 0.85 0.8 0.8 0.9 0.9 Micro spray 0.8 

Macadamia nut 30 60 0.85 0.85 0.85 0.9 0.95 0.95 0.95 0.95 0.95 0.95 0.9 0.9 Micro spray 0.8 

Ti 24 48 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 Micro spray 0.8 

Dillisgrass 24 48 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 Sprinkler 0.75 

Bermudagrass 24 48 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 Sprinkler 0.75 

St. Augustina 24 48 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 Sprinkler 0.75 

Zoysiagrass 24 48 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 1.0 Sprinkler 0.75 
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Fig. 1. HI Mauna Loa 5 NNE Mauna Loa Observation, NOAA Earth Systems Research 
Lab.,Global Monitoring Division (Source: NCDC-NOAA). 

 
Fig. 2. University of Hawaii Waiakea Experiment Station is named as HI Hilo 5 S (Source: 

NCDC-NOAA).
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Table 3. Climate stations and characteristics of the ten target systems. 
--------------Rain--------- --------------ET----------- 

System STATION 

Map ID 
Number 

(Appendices 
4a-4d) 

State 
Key 

Number 
Island Elevation 

(ft) Latitude Longitude Years 
of 

record Perioda 

Annual 
mean 
(in) 

Years 
of 

record period 

Annual 
mean 
(in) 

Kekaha Mana 1 1026.0 Kauai 10 22.04 -159.77 45 1950-
1995 28.4 4 1962-

83 60.3 

Kekaha Kekaha 2 944.0 Kauai 10 21.97 -159.71 48 1950-
1999 21.3 9 1960-

83 58.9 

Kauai Coffee Wahiawa 3 930.0 Kauai 215 21.90 -159.56 54 1950-
2004 35.3 15 1960-

83 67.2 

Kauai Coffee McBryde Station (ET) 4 986.1 Kauai 630 21.92 -159.54 0 -- -- 16 1960-
83 62.5 

Kauai Coffee Bydswood Station 
(rain) 5 985 Kauai 720 21.93 -159.54 50 1952-

2004 59.2 0 -- -- 

East Kauai Lihue Variety Station 6 1062.1 Kauai 340 22.03 -159.39 36 1964-
1999 73.5 11 1965-

83 54.8 

Waiahole Kunia Substation 7 740.5 Oahu 285 21.39 -158.03 10 1994-
2005 20.8 9 1994-

2005 57 

Waimanalo Waimanalo 
Experiment Station 8 795.1 Oahu 60 21.34 -157.71 29 1970-

2000 42.5 31 1970-
2000 47.5 

Molokai Kualapuu Reservoir. 
(ET) 9 531.1 Molokai 800 21.16 -157.04 0 -- -- 11 1970-

1984 94.2 

Molokai Kualapuu (rain) 10 534.0 Molokai 870 21.16 -157.04 26 1950-
1977 33.8 0 -- -- 

West Maui Pohakea Bridge (Rain) 11 307.2 Maui 165 20.82 -156.51 40 1950-
2004 19.4 0 -- -- 

West Maui Field 906 (ET) 12 310.1 Maui 160 20.83 -156.50 0 -- -- 19 1962-
83 77.7 

Upcountry Kula Branch 13 324.5 Maui 933 20.76 -156.33 24 1979-
2005 23.8 23 1979-

2005 49.5 

Waimea Lalaumilo Field Office 14 191.1 Hawaii 2620 20.01 -155.69 23 1981-
2004 16.9 4 1976-

84 51.4 

Lower 
Hamakua Hamakua Makai 15 221.3 Hawaii 750 20.05 -155.38 0 -- -- 15 1964-

1982 63.7 

Lower 
Hamakua Paauilo 16 221.0 Hawaii 800 20.04 -155.37 55 1950-

2005 94.9 0 -- -- 
aTime period includes missing or incomplete years not used in the study and not included in the “years of record” column.
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Table 4. Representative soils for each of the ten target systems. 
System Station soil series Texture Water holding 

capacity (in/in) 
East Kauai Lihue 

Variety 
Kapaa  Silty clay 0.14 

Kauai Coffee Wahiawa Makaweli Stony silty clay 
loam 

0.15 

Kauai Coffee Brydswood Koloa Stony silty clay 0.11 

Kekaha Kekaha Kekaha Silty clay 0.105 

Kekaha Mana Lualualei Clay 0.115 

Waiahole Kunia.Sub Kunia Silty clay 0.13 

Waimanalo Wai.Exp.Sta Waialua Silty clay 0.14 

Molokai Kaunakakai Molokai Silty clay loam 0.12 

West Maui Pohakea Pelehu Clay loam 0.13 

Upcountry Kula Kula Loam 0.14 

Waimea Lalaumilo Waimea V. fine sandy 
loam 

0.14 at 0-50 in 
0.02 at 50-90in 

Lower 
Hamakua 

Paauilo Paauhau Slty clay loam 0.14 at 0-50 in 
0.06 at 50-90 in 

 

4. CALIBRATION AND VALIDATION 

IWREDSS was calibrated for various scenarios and validated with data from the USDA-

NRCS Handbook Notice 38 that comprises net annual water requirement maps for 

various crops grown on the major islands of Hawaii. A range of truck crops were selected 

(Egg Plant, Tomato, Cabbage, Ginger, Dry Onion, Sweet Potato, Lettuce, Watermelon, 

Taro). Irrigation requirements were calculated for truck crops and banana at two locations 

on each island. The trickle / drip irrigation system was selected since it is commonly used 

in Hawaii. Table 5 presents a summary of IWREDSS calculated irrigation requirements 

and their corresponding estimates from the USDA-NRCS Handbook 38 (USDA-NRCS, 

1996).  

Table 5 also shows the percent differences between the two calculations. Net 
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irrigation requirements (NIR) reported by the USDA-NRCS Handbook 38 were 12.8 and 

25.6% higher than those calculated with IWREDSS for egg plant and lettuce in Waimea 

and north Kohala, respectively. Handbook 38 NIR calculations were also, 10.6 and 11.0% 

for cabbage and egg plant in Hoolehua, respectively. The difference in the estimates was 

expected since the NRCS technique is more general and was not used for a specific crop 

such as the calculation of the IWREDSS. 

Regression analysis between the calculations of IWREDSS and those of the 

NRCS Handbook 38 was conducted (Figure 3). Results of this regression show that there 

was a good agreement between the two techniques (R2 = 0.97). However, NIR 

calculations of Handbook 38 were constantly higher than those of IWREDSS by almost 

8%.  

Table 5. Table Calibration and validation 
Scenario Annual NIR (in) 
Location, Crop, Irrigation System IWREDSS USDA-NRCS maps 

Variation 
% 

Waimanalo (OA), Banana (init)-Drip 37.5 38.0 1.32 
Waimanalo (OA), Banana (rtn), Drip 36.9 38.0 2.89 
Waimanalo (OA), Banana, Trickle-Spray 37.5 38.0 1.32 
Waimanalo (OA), Egg Plant, Trickle-Drip 36.3 38.0 4.47 
Waianae (OA), Tomato, Trickle-Drip 61.8 59.0 4.53 
Waianae (OA), Ginger, Trickle-Drip 58.5 59.0 0.85 
Waianae (OA), Cabbage, Trickle-Drip 56.0 59.0 5.08 
Waianae (OA), Egg Plant, Trickle-Drip 51.4 56.0 8.21 
Waianae (OA), Dry Onion, Trickle-Drip 55.1 56.0 1.61 
Waianae (OA), S. Potato, Trickle-Drip 57.1 56.0 1.93 
N. Kohala(HA), Alfalfa (init), Trickle-Drip 44.1 43.0 2.49 
N. Kohala(HA), Alfalfa (rtn), Trickle-Drip 44.1 43.0 2.49 
Waimea (HA), Tomato, Trickle-Drip 34.7 38.0 8.68 
Waimea (HA), Dry Onion, Trickle-Drip 35.4 38.0 6.84 
Waimea (HA), Ginger, Trickle-Drip 35.6 38.0 6.32 
Waimea (HA), Cabbage, Trickle-Drip 16.6 15.0 9.64 
Waimea (HA), Egg Plant, Trickle-Drip 15.7 18.0 12.8 
N. Kohala (HA), Lettuce, Trickle-Drip 13.4 18.0 25.6 
Kula (MA), Watermelon, Trickle-Drip 35.7 37.0 3.51 
Kula (MA), Ginger, Trickle-Drip 40.3 37.0 8.19 
Kula (MA), Tomato, Trickle-Drip 40.0 37.0 7.50 
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Kula (MA), Egg Plant, Trickle-Drip 36.1 37.0 2.43 
Kula (MA), Cabbage, Trickle-Drip 35.0 37.0 5.41 
Kula (MA), Lettuce, Trickle-Drip 36.5 37.0 1.35 
Haiku (MA), Banana (init), Trickle-Drip 41.1 42.5 3.29 
Haiku (MA), Banana (init), Trickle-Drip 29.9 32.0 6.56 
Haiku (MA), Banana (init), Trickle-Drip 28.4 30.0 5.33 
Hoolehua (ML), Banana, Trickle-Drip 65.9 65.0 1.37 
Hoolehua (ML), Banana, Trickle-Spray 62.4 65.0 4.00 
Hoolehua (ML), Cabbage, Trickle-Drip 67.1 60.0 10.6 
Hoolehua (ML), Egg Plant, Trickle-Drip 67.4 60.0 11.0 
Hoolehua (ML), Lettuce, Trickle-Drip 61.6 60.0 2.60 
Kaunakakai (ML), Banana, Trickle-Drip 56.2 60.0 6.33 
Kaunakakai (ML), Taro, Trickle-Drip 74.4 75.0 0.80 

Validation of IWREDSS outputs with NRCS results

y = 0.9258x + 3.6898
R2 = 0.9693
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Figure 3: Validation of IWREDSS with USDA-NRCS results 
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5. MAPPING THE MODEL RESULTS 

The simulation results for all water budget components can be visualized in ArcMap. For 

further analyses, all ArcGIS functions can be used on these output layers i.e., labeling, 

classifying the parameters into various categories, merging or clipping more than one 

layer, and/or application of field calculator to generate further data from the attribute 

tables of the layers. 

 

6. SENSITIVITY ANALYSIS 

Sensitivity analysis is used to quantify the impact of input parameters on the model 

results/output. If a small change in a input parameter results in relatively large changes in 

the output, the model is considered to be sensitive to that parameter. This  mean that the 

parameter has to be determined very accurately.  

Seed corn was selected for the sensitivity analysis because it has become a 

popular and economically important crop in Hawaii. Table 6 shows some information 

about seed corn, the acreage of which in Hawaii is expected to increase over 57 % 

(NASS, 2006). The Trickle/drip irrigation system was used in these calculations due to its 

common use in Hawaii irrigated agriculture. The water requirements/allocations were 

simulated for a four-month-growing season with twelve different planting dates (from 

January until December). An average LAI value of 2 was used for the entire growing 

season. Water table depth was selected at 50 ft to consider deep water table conditions 

with no effect on IRR calculations. The values of these parameters were kept the same for 

all the simulations; there were 12 simulations for windward (Waiamanalo) and 12 

simulations for leeward (Kunia) sides of Oahu. Efforts were made to conduct simulations 

for the same soil type.  

Table 6: Sweet corn: Acreage, yield, production, price, and value, in Hawaii, 1999-2003. 
Year Acres Yield per acre Production Farm price 

  1,000 pounds Cents per pound 

1999 450 3.8 1,700 58.0 

2000 440 5.5 2,400 55.0 

2001 440 4.3 1,900 64.0 

2002 610 3.9 2,400 54.0 

2003 830 3.0 2,500 51.0 
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The results of the sensitivity analysis are shown in Appendices 5a and 5b. The net 

irrigation requirements for the 12 different growing periods are plotted in Figure 4. There 

is a significant difference in NIR for windward and leeward sides of the island. The NIR 

were the least during the rainy season of the year (November to April) and the highest 

during the dry season of the year (May to October) regardless of the location on the 

island. On average, it requires almost twice as much water to grow Seed Corn in the 

leeward side of the island as it does in the windward 

0

4

8

12

16

Ja
n-

A
pr

Fe
b-

M
ay

M
ar

-J
un

A
pr

-J
ul

M
ay

-A
ug

Ju
n-

Se
p

Ju
l-O

ct

A
ug

-N
ov

Se
p-

D
ec

O
ct

-J
an

N
ov

-F
eb

D
ec

-M
ar

Assumed growing periods

N
IR

 (i
n)

Waiamanalo
Kunia

 
Figure 4. Changes in NIR based on changes in growing periods for seed corn grown on 
windward (Waiamanalo) and leeward (Kunia) sides of Oahu. 

 

6.1 Effect of Crop Leaf Area Index on Irrigation Allocations 

For seed corn (growing season: April 15 to August 15), the NIR correlated negatively 

with  effective rain (ER) and correlated positively with leaf area index (Figure 5). NIR 

increased and ER decreased by almost 5% and 3%, respectively for every unit increase in 

the average LAI (Figure 6).  
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Figure 5: Effect of changes in leaf area index on net irrigation requirements and effective 
rain for Seed Corn grown in Waimanalo Oahu, Hawaii.  

 

 

 

 

 

 

 

 

 

 

 

Figure 6. Percent change in net irrigation requirements (open symbol) and effective rain 
(closed symbol) as a result of changes in leaf area index for Seed Corn grown in 
Waimanalo Oahu, Hawaii. 
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7. SIMULATION FOR ENERGY CROPS 

Energy crops are the crops that could be used to produce energy in forms of heat or liquid 

fuel. Bioenergy crops often include food crops such as corn (starch for ethanol 

production) and sugarcane (sugar for ethanol production). The water budget components 

for these two energy crops (Sugarcane and Corn) were simulated for the dry and rainy 

growing seasons for wind- and leeward sides of the islands of Hawaii, Oahu, Maui and 

Kauai. 

Growing seasons and their lengths for the selected energy crops are given in Table 

7. Sugar cane has one year length irrigation seasons starting in May and October referred 

to as dry and wet seasons, respectively. For corn, the dry and wet seasons start in April 

and October, respectively. 

Table 7. Energy crops and growing seasons selected for simulating irrigation 
requirements. 

Crop Season Sowing Harvesting Length of season 

Corn Dry April 15 August 15 123 
Corn Wet October 15 February 15 124 
Sugar cane Y-2 Dry May 1 April 1 365 
Sugar cane Y-2 Wet October 1 November 30 365 

The results of the simulations are given in Table 8 and plotted in Figure 7. There 

is between 0.2 and 22% difference (Table 9) in NIR calculations for Sugarcane; during 

the rainy and dry seasons across the major Hawaiian Islands. However, the difference 

between rainy and dry season for Corn ranges between 63 and 88%. These variations are 

attributed to the temporal variability of rain and ET throughout the different growing 

seasons for these crops. 

Table 8: Net irrigation requirements (in) for energy crops grown on windward and leeward sides of the 
islands in dry and wet seasons 

Crop Irrigation 
season 

Waiamanalo 
Oahu 

windward 

Kunia 
Oahu 

leeward 

Kula  
Maui 

 windward 

W. Maui 
Maui 

leeward 

Waimea  
Hawaii  

windward 

Kekaha 
Hawaii 
leeward 

Lihue  
Kauai 

 windward 

Kekaha 
 Kauai 

 leeward 
Corn Dry 8.1 14.4 12.0 23.2 10.8 11.5 5.3 16.0 
Corn Wet 1.0 4.6 2.8 9.3 3.2 4.3 1.3 4.3 
Sugar 
C. Y-2 

Dry 13.8 32.4 26.4 50.4 26.3 33.7 8.2 34.7 

Sugar 
C. Y-2 

Wet 15.2 32.9 26.7 50.5 25.0 33.0 10.6 36.2 
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Table 9: Percent difference in the NIR calculated for energy crops during dry and wet seasons 

Crops 
Waiamanalo 

Oahu 
windward 

Kunia 
Oahu 

leeward 

Kula  
Maui 

 windward 

W. Maui 
Maui 

leeward 

Waimea  
Hawaii  

windward 

Kekaha 
Hawaii 
leeward 

Lihue  
Kauai 

 windward 

Kekaha 
 Kauai 

 leeward 

Corn 88 68 77 60 70 63 75 73 

Sugarcane 9.2 1.5 1.1 0.2 4.9 2.1 22.6 4.1 
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Figure 7: Net irrigation requirements for the energy crops (a) Corn and (b) Sugarcane 
grown on various locations across the five major Hawaiian Islands. 
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8. SUMMARY AND CONCLUSION 

This is a final report on the project “Water Management Software to Estimate Crop 

Irrigation Requirements for Consumptive Use Permitting inn Hawaii”. ArcGIS based 

IWREDSS model was developed, calibrated, validated, and tested through a sensitivity 

analysis. The report presents and discusses results of the calibration, validation and 

sensitivity analysis. Hardware and software requirements are given in the IWREDSS user 

manual (Appendix 1). Details of the governing equations and methodologies are given in 

the technical guide (Appendix 2). 

IWREDSS was calibrated and validated for truck and energy crops based on data 

of the USDA-NRCS Handbook 38. A close agreement was observed between the 

estimates of the two techniques. A sensitivity analysis was also carried out to test the 

sensitivity of IWREDSS to input parameters. IWREDSS was sensitive to the timing of 

the growing season due to the temporal variations of rainfall and ET. The LAI had 

positive effect on NIR. IWREDSS is capable of calculating and visualizing water budget 

components. It comes with the following features: 

• It estimates irrigation requirements for multiple crops/land uses, i.e., vegetable 

and fruit crops, lawn and golf courses for different time intervals: daily, weekly, 

bi-weekly, monthly, seasonally, and annually. 

• It uses long-term historical climate databases of daily ET and rain, from different 

locations within Hawaii, to calculate daily water budgets of the crop root zone. 

• It estimates IRR based on extreme event probabilities calculated from daily 

irrigation requirements simulated. The year-to-year distributions are used to 

calculate extreme values by fitting a theoretical function to the actual annual data. 

A coefficient is calculated which indicates how well the data fit the theoretical 

distribution so the user can determine whether the data base is sufficiently long to 

accurately estimate the desired extreme values.  

• It estimates IRR for common Hawaii irrigation application systems, including 

sprinkler, surface, micro and seepage systems. All four types of systems are 

included in the model by simulating the effects of periodic irrigations of the entire 

soil surface with sprinkler and surface irrigation systems, high water tables in 

seepage irrigation systems, and partial root zone irrigation in microirrigation 
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systems. 

• It uses inputs which describe crop, soil, irrigation system, and management 

parameters. Default values are included for each input, based on typical Hawaii 

conditions; however, the user can change them based on a specific condition.  

• The model is flexible enough to allow the users to include more input data about 

crops as it become available for a specific application or based on the most recent 

research results.  

• Data output of the model is used to develop GIS maps of IRR and other water 

budget components. 
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10. APPENDICES 
 
Appendix 1. 

USER MANUAL 
ArcGIS based graphical user interface of the Irrigation Water Requirement Estimation 

Decision Support System (IWREDSS) enables user to calculate irrigation requirements 

for the area of interest. Irrigation requirements can be calculated by either using a Tax-ID 

GIS layer or by using a georeferenced map of the area. This manual includes the details 

on how to digitize a hard copy of the area of interest. The user inputs include crop to be 

grown/irrigated, crop leaf area index (LAI), the growing season, irrigation system to be 

used, appropriate curve number, and water table depth. In addition to these inputs, 

IWREDSS uses the corresponding weather and soil data from its Geodatabases. 

IWREDSS results can be retrieved and visualized in the form of a text (ASCII) file and a 

GIS map upon successful execution. 

System Requirement 
 
Hardware 
The system should have minimum specifications of Pentium III, 256MB memory, and 

800MB hard drive space.  

Software 
IWREDSS was developed and tested on Windows XP with installed applications of 

ArcGIS 9.2 (ESRI product) and JRE (Java Runtime Environment) 5.0. JRE can be 

downloaded at http://java.sun.com. The following steps need to be completed to 

successfully operate the program. 

Installation of IWREDSS 
1. Copy the project files (IWREDSS.mxd) and data folder (data) to any location on the 

hard drive of the machine. The IWREDSS.mxd initiates ArcMap application of 

ArcGIS and the data folder contains geodatabases of soil, climate, taxID, ALISH, 

LSB and an executable file of IWREDSS. 

2. Set system variable “IWREDSS_HOME” to be the location of IWREDSS (Figure 1). 

Note that you need to include a “/” at the end the name of system variable. This can 

usually be don via Control Panel -> System -> Advanced -> Environment Variables -

> System variable- >New >OK.  
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Figure 1 
 
Simulation using IWREDSS 
The user needs to select a TaxID area on any of the major Hawaiian Islands or provide a 

GIS georeferenced layer. 

 
Area simulation using TaxID 
Step 1: Open the ArcMap document 
Open the file “IWREDSS.mxd” by double- or by right-clicking. An alternative way is to 

launch ArcMap first, then open the document “IWREDSS.mxd” using the File->Open 

menu or from ArcMap dialog, click the option to start using ArcMap with An existing 

map, then click OK to browse for IWREDSS.mxd file. The document opens displaying a 

map of Hawaii with polygons of different Tax ID areas (Figure 2). 
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Figure 2 
 
The table of content (TOC) of ArcMap (a list on the left side of the window) includes the 

following visible layers: 

LSB: Land Study Bureau. 

ALISH: Agricultural Lands of Importance to the State of Hawaii. 

TaxID:The TaxID areas of all the islands 
station: The climate stations whose historical daily rainfall and ET data are used by 

IWREDSS. 
Rain: Raster layer of rainfall. It contains annual average precipitation of every pixel on 

the map. The values are calculated from the rainfall isohyets (Giambelluca, et al., 

1986). This layer is unselected by default. 

ET: Raster layer of evapotranspiration which contains annual average Pan ET of every 

pixel on the map. The values are calculated from the pan ET contours (Ekern and 

Cheng, 1985). This layer is unselected by default. 

SOILS: This soil layer presents the soils of Hawaii used in simulation. 

The above layers may be at different order in TOC. 
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Step 2: Select a TaxID area 

Locate the area of interest on one of the Hawaiian islands. It is suggested to zoom in the 

the island of interest and click on the Tax-ID (irregular shaped polygons, sections on the 

map) specific to the area of interest. There are two ways to select a Tax-ID area as 

follows: 

1. Directly select on the map. 

 a) Using Zoom-in tool  find the area to be irrigated/simulated. 

 b) Using Feature-selection tool  select the area as shown in Figure 3. Note that 

with this option you can only choose 1 area (Tax-ID) per simulation. 

 

Figure 3 
 

2. Area selection using the attribute table of the Tax-ID Layer (Figure 4). 

a) In TOC, right click on TaxID and choose “Open Attribute Table” from the pop-up 

menu. 

b) In the attribute table, select Options->Select by Attribute, and then you can search 

by TMK or other features (like all areas larger than 300,000 acres) 

c) After clicking “apply”, the matched record(s) and their corresponding area(s) will 
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be highlighted. If there are more than one matched records, you need to select one. 

d) Select TMK number chosen for simulation. 

 
Figure 4 
 
Step 3: Selection of the other Input Parameters 

After selecting an area, the user will need to input other required parameters by clicking 

the IWREDSS tool button . The following window (Figure 5) will pop up. 

User will need to input/select the following parameters: 
Crop: User can select from the predefined list of crops given below:  
16 PERENNIAL CROPS 
GENERIC CROP 
COFFE         
DENDROB.,POT  
DRACEANE,POT  
EUCALYP.,OLD  
EUCALYP.,YNG  
GUAVA         
HELICONIA     
KIKUYU GRASS  
LYCHEE        
MACADAMIA     
TI 
DILLIS GRASS 
BERMUDA GRASS 
ST.AUGUSTINA 
ZOYSIA GRASS 
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23  ANNUAL CROPS  
GENERIC CROP 
ALFALFA,INIT 
ALFALFA,RATN 
BANANA,INIT  
BANANA,RATN  
CABBAGE      
CANTALOUPE   
DRY ONION    
EGG PLANT    
GINGER,(AWD) 
LETTUCE      
OTHER MELON  
PINEAPP.YR-1 
PINEAPP.YR-2 
PUMPKIN      
SEED CORN    
SUGAR C.YR-1 
SUGAR C.YR-2 
SUGAR C.RATN 
SWEET POTATO 
TARO         
TOMATO       
WATER MELON 

 

 

 

Figure 5: Interface of  

IWREDSS 

 

Each crop has 

its own parameters 

included in the crop 

database of IWREDSS. 

For perennial crops, the parameters include irrigate crop zone depth, total zone depth, 

monthly crop water use coefficient (KC), and monthly allowable water depletion (AWD). 

For annual crops, the crop parameters include initial crop zone depth, maximum crop 

zone depth, fraction of growth of 4 stages, crop water use coefficient (KC) of 4 stages, 

and allowable water depletion (AWD) of 4 stages. 

Additional crops can be added to the list as needed. 

Max LAI: Maximum Leaf Area Index is used to calculate rainfall canopy interception. 

For details of the calculation of interception, please refer to IWREDSS User Guide. 
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Irrigation period: User needs to specify the start and end of the growing season that can 

be up to 1 year long; it can start at any month of the year and can go around to the 

next year, i.e. starting date October of year one and ending date September of the 

following year. Note that if the irrigation period is too short (less than 45 days) for 

some annual crops, the simulation results would not be accurate. 

Irrigation system: The users can select from the predefined list of irrigation systems 

given below: 

USER-SPECIFIED SYSTEM 
TRICKLE, DRIP 
TRICKLE, SPRAY 
MULTIPLE SPRINKLER 
SPRINKLER, CONTAINER NURSERY 
SPRINKLER, LARGE GUNS 
SEEPAGE, SUBIRRIGATION 
CROWN FLOOD 
FLOOD (TARO) 

For different irrigation systems mentioned above, the following parameters should be 

defined; system application efficiency, fraction of soil surface irrigated, and fraction 

of evapotranspiration. 

Option for no irrigation: A provision is given to calculate water budget components 

without supplying additional irrigation. This option could be used for research 

purpose as to simulate natural rainfed cropping system.   

Irrigation practice: The users are given options to select irrigation practice. A dropdown 

menu provides options for irrigation practices including a) Irrigate to field capacity 

(normal practice), b) Apply a fixed depth per irrigation, and c) Deficit irrigation. In 

case option “b” is selected, the users are asked to enter the depth of irrigation in 

inches. Percentage of deficit irrigation is required to enter in case option “c” is 

selected. 

 
Additional Parameters: For the following list of the irrigation systems, additional 

parameters are needed.  

IR System Extra parameters 
Crown Flood System Crown flood System bed height 
Seepage System Depth to water table 
Flood System Rice flood storage depth 
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The additional parameters (in inches) can be entered in a box provided next to the 

Irrigation System box. When extra parameters are not needed, this box is grayed 

out. 

Soil Hydrological Groups and SCS Curve Numbers: Based on the SCS curve number 

method, all soils are grouped into 4 hydrologic groups (A, B, C, and D). Based on the 

composition of the selected area, IWREDSS calculates the % of each soil group with 

respect to the total superficie of the selected area (for example, a selected area may 

have 11.3% of group B, 22.8% of group C, and 64.8% of group D). Based on the land 

use, the user should specify the corresponding SCS curve number for all the soil 

hydrologic groups present in the area of interest. The curve number is used in the 

calculation of runoff. For details of the calculation, please refer to IWREDSS User 

Guide. 

 By default, a CN value of 78 is 

given for each hydrologic 

group to remind users that they 

need to change these values to 

their correct values. To see a 

list of CN values for different 

cover and soil types the user 

needs to click “?” button next 

to the CN input box (Figure 6). 

 
 
 
 
 
 
Figure 6: CN numbers 

 

Depth to water table: This site-specific information is optional as the model considers 

50 ft of water table depth. It is recommended to use the default depth unless the 

precise value of water table depth is known. Note that the unit of water table depth is 

in feet. 
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Location: This is the name of location or area of interest and any additional information 

the user wants to add to the title. The name appears in the beginning of the 

IWREDSS text output file. 

Step 4: Execute IWREDSS 
After completing the required inputs, the user should click the “Run” button to start 

simulation. A text box message will be prompted to the user about the state of simulation 

(fails or succeeds) (Figure 7). 

Step 5: Reading the result 
After successful execution, a message (Figure 7) pops up giving user an option to view 

the results. A text file opens by clicking the “Yes” button on the option message box. By 

default, the output file is saved in the subfolder “data” of the installation folder of 

IWREDSS with the default name as “IWREDSS_out.txt” and is automatically 

overwritten by successive execution. Therefore, the user 

is advised to save the results after every simulation with a 

different name using the File>Save as option in notepad.                                                                                 

       

Figure 7: 

 
The output text file contains three major sections: a legend table, simulation 

parameters and simulation results. The legend table defines the abbreviations of 

parameters used in the output and their corresponding units. These parameters include the 

inputs parameters described in step 3 and the predefined parameters for crop type, 

irrigation system and soil type. The simulation results are presented for different time 

periods; yearly average, monthly average, bi-weekly average and weekly average. These 

results are presented for each soil series that has over 1% of the total area. 

At the end of the output file, there is a summary of the results. IWREDSS would 

calculate irrigation requirements for each of these soils independently. The total irrigation 

requirements for the area of interest will be the weighted average of all the soils available 

in that area using the following formula: 

IRR = IRR1 * A1 / AT + IRR2 A2 / AT + … + IRRn * An / AT 

where IRRi , Ai are the calculated irrigation requirements, and the area occupied by i-th 
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soil type, respectively; AT is the total superficie of the different soils of the Tax-ID area of 

interest. Note that IWREDSS will not simulate irrigation requirements for the non-arable 

parts of the area of the TaxID; thus, the sum of the sums of all A’s will not be equal if 

there are non-arable part of the area of interest. In these cases, the proportion will be 

normalized so as to add up to 1. The list of all the simulated soil types and corresponding 

proportion of each of them are given in the beginning of the summary section of the 

report. 

Step 6: Ploting the result 

After the text output, the user is prompted to select to plot the results (Figure 8). The 

results are plotted on the map based on the yearly irrigation requirements for the different 

soil types in the TaxID area.  

    

Figure 8 
 

An example of color plotting is given in Figure 9. The user can visualize the results on an 

enhanced option (Figure 10) by clicking the  button to zoom to the whole TaxID Area. 
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              Figure 9 

 

             Figure 10 
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Simulation of user’s provided layer. 
Simulation of an actual location and net acres on a parcel can be conducted by using a 

layer provided by the user. Ideally user’s layer need to be a georeferenced GIS layer. In 

case user’s layer is in the shape of a parcel or a farm map, it needs to be digitized, 

georeferenced, saved as a polygon shapefile and have attribute table containing fields 

including FID, SHAPE, ID, ISLAND. Stepwise procedure on how to digitize from a 

parcel map is referred in the Technical Guide of IWREDSS. 

The irrigation requirements for a user’s specified GIS layer can be simulated using two 

methods. The user needs to provide a Georeferenced GIS boundary layer of the area of 

interest e.g. an agricultural field or a golf course. Method 1 gives a detailed text output 

including information about soil and other statistics. Method 2 gives a summarized table 

of the simulated water budget components and therefore is quicker. Both methods gave 

the same estimates of water budget components. 

Method 1.  

1. Add the Georeferenced GIS layer of which irrigation requirements need to be 

calculated to the TOC of ArcMap (IWREDSS program). 

2. If you have a paper copy of an agricultural field, a lawn or a golf course, scan the 

image and save it with extension .img or .jpeg. Digitize the layer following the steps 

explained in section “How to digitize in ArcGIS” in IWREDSS Technical Guide. 

2. Overlay the layer on existing TMK layer (TaxID). Your layer may occupy more 

than one TMK. In the following figure, a layer “WUH” (Waimanalo experimental 

research station of the University of Hawaii-Manoa) has been overlaid on the TMK layer 

of Oahu.   
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3. Run simulation for the TMK on which the layer falls 

4. Run multiple simulations in case the layer falls on more than one TMK (as is the 

case of “WUH” layer. 

5. Plot the simulation results (merge TaxID simulations results in case of multiple 

simulations). The output layers can be merged using “Merge (management)” tool as 

shown in following figure. The tool can be accessed by typing in the keyword “merge” in 

the “Index” table of ArcToolbox. 
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6. Clip the simulated result (individual or merged) with the user’s layer following  

ArcToolbox > Analysis Tools > Extract > Clip as shown in the following figure. 

 

7. The clipped layer contains all the simulation results for the user specified layer. 

The text results can be obtained from the text output files. 
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Method 2. 

1. Add the folder containing supporting files of Georeferenced GIS user’s layer in 

“IWREDSS\data\GIS” 

2. Create a folder “XXX_Soil” in IWREDSS\data\GIS, where XXX is the name of 

user’s layer. The name of the folder is case sensitive. 

3.  Add user’s layer in ArcMap TOC 

from “IWREDSS\data\GIS\folder containing 

layer” (Step 2 of Method 1). 

4. The attribute table of the layer must 

contain fields including FID, Shape, Id, 

ISLAND, and AREA. The AREA field 

should have data “Type” as “double”. The 

ISLAND filed should have data “Type” as 

“Text” and “Length” equivalent to 10. 

 

 

5. Values for the AREA field can be calculated using Pre-Logic VBA script code as 

follows. 
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6. Input file for IWREDSS can be prepared by clicking the database button  besides 

IWREDSS button . (Buttons for IWREDSS execution and input file preparation are 

both located in the Tools toolbar). 

7. Clicking  prompts a message box asking user to type in the name of user’s 

layer (CASE SENSITIVE). Enter the layer name and click OK button. This executes a 

code to prepare input files (database).  

 
8. After a successful execution, a layer with the name “XXX_Soil” will be 

automatically added to the TOC of ArcMap. 

9. Clicking IWREDSS button  brings an interface that requires input 

parameter selections. 

10. From dropdown menus select the name of Island and the name of the user’s 

layer (case sensitive). (Complete Steps 3 through 6 i.e., complete the other 

input parameter selections. Hit “Run” to start simulation, “Yes” to continue, 

“Yes” to see text simulation results, and “Yes“ to plot the simulation results. 
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Appendix 2. 

TECHNICAL GUIDE 
 
GeoDatabases, datasets and layers 
Beside the visible layers in the table of contents of ArcMAP, the following datasets are 

also part of the IWREDSS package: 

TaxID_Soil_Statistics: is the dBase dataset of the intersection between Tax-ID layer and 

Soil Layer. To ensure efficient calculations by IWREDSS, the original 

intersection is summed by Tax-ID polygon and soil type so that there will be 

only one record for each soil type in one Tax-ID area. . 

Alish_Soil_Statistics: is the dBase dataset of the intersection between Alish layer and 

Soil Layer. Note in order to calculate efficiently, the original intersection is 

summed by Alish polygon and soil type so that there will be only one record for 

each soil type in one Alish area. . 

LSB_Soil_Statistics: is the dBase dataset of the intersection between LSB layer and Soil 

Layer. Only the soil categories A, B, C, and D in LSB areas are included in the 

simulation as the category E is conservation lands. In order to improve the 

calculation efficiency, the original intersection is summed by LSB polygon and 

soil type so that there will be only one record for each soil type in one LSB area. 

. 

User’s provided layer: There could be other layers for simulation and their 

corresponding intersection layer (with soil) and statistic dataset should also be 

named as XXX_Soil and XXX_Soil_Statistics. (XXX is the layer name). 

 

IWREDSS Mechanism 
Area simulation 

Upon user’s clicking on the IWREDSS tools button , the following data collection 

process is launched: 

1) Get the user’s selection; make sure there is only one selected area (of all layers); get 

the name of the layer the selection belongs to. 

2) Query the statistic dataset described above (the datasets of the layer the selected area 

belongs to) to get all the soil types and corresponding proportions and hydrologic 
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groups inside the selected area; note that non-arable soil types such as water, quarry 

will be filtered out before sending them to IWREDSS for simulation, and soil types 

that are of less than 1% of the whole area will not be simulated; get the summation of 

each hydrologic group for user’s reference of CN specification later. 

3) Find the geographically closest climate station (from the station layer) to the centroid 

of the selected area; use the raster layers Rain and ET to get the annual average 

rainfall and ET of the closest station and those of the centroid of the selected area so 

as to get the approximate ratios of rain and ET between the station and the area of 

interest. The historic daily climate records (rain and ET) of the climate station will be 

multiplied by these ratios to calculate their site specific values during the simulation: 

Rain_of_the_area = Rain_Ratio * Rain_of_Station 

ET_of_the_area = ET_Ratio * ET_of_Station 

 The ratios are also shown on the parameter window. 

4) Open the dialog to accept user’s input; assign the CN of each hydrologic soil group to 

all the soil types of that group; launch IWREDSS; get results summary from 

IWREDSS log; prompt error if fails, or confirmation if succeeds. 

 

Data Plotting 
After a successful execution, plotting is done upon request. The followings explain how it 

is done by the VBA code. 

1. Area simulation (XXX is the name of layer the selected area belongs to)  

1) Add the intersection layer of the simulated area to the map, i.e. 

data/GIS/XXX_Soil/XXX _Soil; 

2) Select all the features (polygons) within the simulated area (the records with 

FID_XXX = FID of the simulated area). 

3) Output the selected features to IRR_PLOT_NNN_TT, where NNN is the island name 

and TT is the current time of the plotting; 

4) Add fields to the attribute table of the output layer, one for each of the water 

components, and set the values to the IWREDSS results 

5) Plot based on GIR field using natural breaks. 

6) Remove the added and unused intersection layer. 

 



 

 39

2. Island simulation (XXX is the name of layer for the simulation) 

Similar to area simulation, with the following differences: 

1) The plotting is for the whole island, and the unit is area instead of soil polygons 

within each area 

2) The plotting is based on the summarized GIR values of each area and the user can 

manually plot on any other water component. 

3) The exported layer includes all areas of the selected island, while some of the areas 

are not simulated because of non-arability. These un-simulated areas will have value 0 

for all water component fields (displayed as white in the plotting). 

 

Procedure for preparing Statistics dataset 
This procedure works behind the input files preparation button  provided besides 

IWREDSS simulation button . The following description is for TaxID-related 

simulations. The procedure for the other layers (ALISH, LSB, etc.) is mostly the same.  

The TaxID layers are obtained from Hawaii State GIS Program 

(http://www.hawaii.gov/dbedt/gis) and the soil layers are provided by the USDA. In case 

there are changes in the TaxID area division or soil type coverage, the statistics dataset 

may need to be reproduced. The following procedure can be followed: 

1) Merge the layers to be one big layer: TaxID. The Merge tool in ArcToolBox provided 

by ArcMap is suitable for this task. 

2) Rename the TaxID layer as 

TaxID. Put it in the 

data/GIS/TaxID folder. Add 

ISLAND field and set values. 

Add area field in the TaxID 

layer and use the following 

pre-VBA code to set the 

value: 
 

3) Use the ArcTool Intersect to 

intersect the TaxID layer and 
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the soil layer; add field NewArea (Double, length 19) to be the area of the intersected 

polygon and field Portion (Double, length 19) to be the proportion of NewArea to 

Area (the field from TaxID layer): NewArea/Area. Output the intersection layer as 

data/GIS/TaxID_Soil/TaxID_Soil. 

4) Add to the TaxID layer field FID_TaxID and set its value to be same as field FID. 

 

5) Add the field TAX_SOIL (Text, length 20) in the intersect layer. Calculate the field 

value as:  

"" & [FID_TaxID] & "_" & [SOIL_CODE] 

The field FID_TaxID is the FID field from TaxID layer which is automatically 

renamed so during the intersection.. 

6) Use the ArcTool Summary Statistics to generate the statistic dataset. The summary 

should be based on TAX_SOIL and output FID_TaxID, TMK, ISLAND, SOIL_CODE, 

NewArea, and Portion. The first three fields can be summarized by first or last while 

the last two fields must be summed. Output the statistic layer as 
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data/GIS/TaxID_Soil/ TaxID_Soil_Statistics. Note if for layer of other names, not 

only the layer name should be changed to XXX_Soil_Statistics, but also the path 

should be changed: data/GIS/XXX_Soil/ XXX_Soil_Statistics 

 

7) Rename the field names of the summary dataset:  

first_fid_tax -> FID_TaxID (Double) 

first_tmk -> TMK (Double) 

first_island -> ISLAND (Text, 10) 

first_soil_code -> SOIL_CODE (Text, 20) 

sum_newarea -> AREA (Double) 

sum_portion -> PORTION (Double) 

The renaming process can be done by first add a new field with the desired name and 

then calculate that field value by assigning it with the old field, and finally delete the 

old field. 

8) Add a field IL_Soil (Text, length 20) in the statistic dataset with the following value: 
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[ISLAND] & "_" & [SOIL_CODE] 

9) Add the data/GIS/Soil/SOIL_HYDROGROUP.dbf; join it to the statistic dataset using 

IL_Soil <-> IL_Soil. Add a new field GROUP (Text, length 1) in the statistic dataset, 

assign the field value to be the field 

HYDROLIC of SOIL_HYDROGROUP, 

then delete the join and remove 

SOIL_HYDROGROUP as 

SOIL_HYDROGROUP.HYDROLIC. 

 

9) Recalculate field PORTION to make all 

portions that are larger than 1 to be 1.as: 

o Open the attribute table 
o "Search by Attribute": "Portion" > 1 
o Switch from all records to selected 

records 
o Right click on the portion field and 

choose "field calculator" 
o In the input box, type in 1 and click 

ok. 
10) Check and make sure the records with 

empty value of field GROUP are fine. 

11) Remove the intersection layer (XXX_SOIL) because it will be added and removed 

automatically to the ArcMap document by code. 

 

Procedure for preparing Statistics dataset (for ALISH and LSB) 
The Alish and LSB layers are obtained from Hawaii State GIS Program 

(http://www.hawaii.gov/dbedt/gis). In case there are changes in the ALISH/LSB area 

division or soil type coverage, the corresponding statistics dataset may need to be 

reproduced. The procedure is similar to that for TaxID case, with the following 

differences: 

1) The original layers of Alish and LSB provided by Hawaii Statewide GIS Program are 

state-wide and don’t have island information. Before intersection, a field in the 
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attribute table indicating the island should be added as shown below. 

 

2) Because the layers are state-wide, the corresponding soil and hydrologic group layer 

need to be merged from island-wide to state-wide. The merge tool in ArcToolBox 

provided by ArcMap is suitable for this task. Note that only some of the fields are 

needed, so you can delete the fields that are not commonly existing in the process of 

merge: 

SOILS: SOIL_CODE 

HYDROGROUP: MUSYM, HYDROLOGIC, ISLAND 
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Procedure for preparing Statistics dataset (for user’s layers) 
This program is designed to be able to handle new layers for simulation. To do that, the 

corresponding layer and dataset need to be prepared as described above. The most 

important things to be careful about are: field names, path and layer names. After all 

datasets are prepared with the correct name in the correct path, the user will be able to do 

exactly the same simulating job as when using the existing three layers. Area simulation 

is also doable by choosing the desired area and run. Currently, the database button  

performs this task for a user’s layer. 

 

IWREDSS CommandLine Parameters 
This is the command line version of the graphic version of IWREDSS. User is required to 

enter the input parameters in the following orders: 

1) Path 

2) Crop Index (starting from 0) 

3) Irrigation Starting Day (0~364) 

4) Irrigation Ending Day (0~364) 

5) Climate Station File Name (without the extension portion of the file name) 

6) Rainfall ratio as defined before 

7) ET ratio as defined before 

8) Irrigation System Index (starting from 0) 

9) Irrigation System Capacity Method Index (starting from 0) 

10) Irrigation System Capacity Method Parameter (0 for Normal Practice) 

11) Soil file name (usually the name of the island, without the extension portion 

of the file name) 

12) Soil types within the simulated area concatenated by comma 

13) Soil proportions corresponding to the soil types parameter (also concatenated 

by comma) 

14) Depth to water depth (in feet) 

15) Max LAI (see table for values) 

16) Curve Numbers corresponding to the soil types parameter (also concatenated 

by comma) 
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17) Name of simulated location and additional comments that will be in the title 

18) Extra Irrigation system parameter 

 

This is a commandline example: 

""C:\WorkSpace\ArcGIS\data/ImansysCLS" "C:\WorkSpace\ArcGIS\data/" " 17 0 

364 kuala 0.4168 1.0105 1 0 0 MOLOKAI 

GL,HzC,KKTC,KcC3,LaC3,LaD3,LuA,MmA,PID,PID2,PJD2,rRK,rRR,rVS,rVT2 

.071,.035,.012,.010,.011,.015,.019,.024,.026,.040,.042,.209,.027,.248,.061 50 1 

78,78,78,78,78,78,78,78,78,78,78,78,78,78,78 "test" " 

 The crop is the 22nd crop in the list (cabbage) 

 Irrigation period is from 1/1 to 12/31 

 Climate station file is “kuala” (kuala.csv) 

 The irrigation system is the 2nd in the list (Trickle, Drip) 

 The irrigation capacity method is the 1st in the list (Normal practice) 

 The irrigation capacity method parameter is 0 (not used in this example as Normal 

practice is selected) 

 The soil data file is MOLOKAI.csv 

 The soil types (MUSYM code) in the simulated area are “GL, HzC, KKTC, KcC3, 

LaC3, LaD3, LuA, MmA, PID, PID2, PJD2, rRK, rRR, rVS, rVT2”  

 The corresponding ratios of the soil types to the area are (omitting the leading zeros) 

“.071, .035, .012, .010, .011, .015, .019, .024, .026, .040, .042, .209, .027, .248, .061” 

 The corresponding curve numbers of the soil types are “78, 78,78, 78,78,78, 

78,78,78,78, 78, 78, 78, 78, 78” 

 The depth to water table is 50 feet 

 The location name of this simulation is “test…….” 

  There is no additional irrigation system parameter based on the irrigation system 

chosen. 

 
IWREDSS-related data 
All the other data files that haven’t been described are of IWREDSS’ use. For more 

details, please refer to IWREDSS User Manual. 
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How to Digitize in ArcGIS 

1. Scan the image of a field and save it as an image file in “.img” or “.jpeg” format. 

2. Open ArcCatalog, right click on your project folder (where your files are located) 

and click , go to “New”, click on “Shapefile”. In “Create New Shapefile” window name 

the new shapefile and select “polyline” as feature type. Select a projection through the 

“Edit” button under “Description box”. You are in Spatial Reference Properties dialog 

box. Click “Select” button, double click “Geographic coordinate systems”, double click 

“North America”, double click “North American Datum 1983.prj, click “Add” button, 

and Click “Ok” at the end. 

3. Open a new ArcMap session and add the scanned image (.img or .jpeg extensions) 

and the newly created polyline shape file, (You will find this file in the folder you created  

from ArcCatalog. You can also drag it from ArcCatalog and drop it in TOC of ArcMap). 

Add an already coordinated/georeferenced layer (It could be the coast line layer of the 

islands or any other layer which have at least three bench marks or proper boundary 

resembling the scanned image). This layer will be named “reference layer” in the rest of 

the document. 

4. Select Toolbars from the “View” menu in ArcMap and click “Editor” to turn on 

the Editor toolbar if it is not already opened. 

5. From the “View” menu go to “Toolbars” and click  “Georeferencing” if it is not 

already opened. 

6. Click the image layer to initiate it. Click the dropdown button of 

“Georeferencing” and click “Fit to Display”. You will see the scanned image on screen. 

7. Right click the reference layer (e.g. island coast layer) and select “Zome to 

Layer”. You should see both the layers (the scanned image and the reference layer) on 

screen.  

8. From “Georeferencing” toolbar click on ‘Add Control Points”, the line with red 

and green x as endpoints. 

9. Click a bench mark (any corner of a park, building or boundary) on the image first 

followed by another click on the reference layer. 
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10. Repeat step 9 at least three or preferably four times to obtain different bench 

marks or until you see the two layers overlaid.  

11. Right click the new shape file and add a new “Field” from the “Options” button 

on the bottom right corner. While creating a new field, select proper features of the filed 

i.e. string for “text” data and integer or double (depending on the size of the data) 

“number” data. Text may be the name of Island and number may be the amount of 

rainfall or PE. 

12. Click the new shapefile to initiate it, and from the “Editor” toolbar select “Start 

Editing” 

13. From the dropdown menu of “Georeference” button, select the new shapefile as 

the target “Layer”.  

14. Zoom to the feature to be digitized, and from the Editor toolbar, select the “Sketch 

Tool” (the pencil icon).  

15. Choose from the following options to create and modify the new feature:  

• To create a polygon feature, left-click once in the Data Frame to start a new 

polygon. Successive single left-clicks will create vertices. Double-click at the last 

vertex to create a closed polygon.  

• If you are editing a point feature class, left-click to add a single point location.  

• If you are editing a line feature, left-click to start a new line and add vertices with 

successive single left-clicks. End the line with a double left-click.  

• If you are in the middle of editing a line and realize that you want to make a 

correction to a part of that line you have already completed, double-click to finish 

the line segment. Then select the “Edit Tool” (the black arrow just to the left of 

the pencil icon in the Editor toolbar). Use this tool to select a feature by double-

clicking it, and move the vertices individually.  

• Use the “Esc” key to get out of a particular step. 

• The Undo option can be quite helpful. To use it, press Ctrl-z; alternatively, from 

the Edit menu, select Undo. If your polygon gets too complicated to fix, you can 

use the Edit Tool to select it, and then delete it by pressing the Del key.  
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Note: You can pan and zoom while in the middle of digitizing a feature. Another handy 

feature is the magnifier window. To open this, from the main ArcMap menu bar, from the 

“Window” menu, select “Magnifier”. This allows you to have a separate window zoomed 

into a portion of the main Data Frame. You can pan and zoom this window around your 

Data Frame, which is a convenient way to follow the path of a long feature. 

16. After the digitizing is complete, enter the information to the attribute table of the 

shapefile. Right click shapefile, click “Open Attribute Table” 

17. Once you have digitized all the features, to save your edits, from the Editor 

toolbar, select “Save Edits” from Editor.  

18. To stop editing, from the Editor toolbar, select “Stop Editing’ from Editor. 

19. Save the shapefile and use it with its supporting files. 

 
How to add new crops in the existing crop list 

IWREDSS gives the option to add a new crop in the existing list of crops. Users need to 

figure out if the crop to be added is annual or perennial. There are two sets of crops in the 

existing list of 16 perennial and 23 annual crops. Detail on crop parameters including 

effective rooting depths, crop coefficients (KC), duration of crop cycle and their 

fractions, and allowable water depletion (AWD) for major annual and perennial crops are 

given in Tables 1 and 2 of the project report.  

To update the existing list of crops: 

• Open croplist.dat with Notepad from IWREDSS\data. The first line in the text 

gives the number of perennial crops followed by the names of the crops in the 

sequence these appear in the interface of the IWREDSS model as demonstrated in 

the following figure. 
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• Update the crop list with the exact number and the names of the crops to be 

added. 

• Save the file croplist.dat before closing it. 

• Open crop.dat with Notepad from IWREDSS\data. The first two lines in the text 

give the number of perennial crops and root zone and water use coefficient data 

i.e., crop name, crop depth (inches), KC, Fraction, and AWD. The list of crops 

and the related coefficients should be updated following the example of the 

existing information as shown in the following figure. 
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• For perennial crops, the crop data occupy the two rows for the two root zone 

depths of Hawaiian crops, minimum and maximum i.e., 0-24 and 24-48 inches, 

respectively. The values of KC and AWD are given in the first and second lines, 

respectively. The root depth data are considered as average data for Hawaii 

conditions. 

• Leave one line space between perennial and the annual crop information. 

• Details on the data for annual crops can be found in Table 1 of the project report. 

The entries in Table 1 and in the above screen shot are explained in the following 

table: 
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Column entries Description 

1st Minimum annual crop irrigated root zone depth. This depth is 

usually irrigated in the beginning of crop season 

2nd Maximum crop irrigated root zone depth. Crops obtain and 

maintain this maximum depth during their growth stages. 

Patterns of crop root zone development are shown in the 

following figure (Case of Seed Corn). 

3rd through 6th The values of KC at initial, mid, and late stages of crop. 

7th through 10th These are fraction of crop growing season under the heading of 

FRACTION. The data represent duration of crop growth stage 

that varies for various crops.  

11th through 14th The fraction of total AWD during the four stages of crop. 

 

 

 

 

 

 

 

 

•  

• Save the file crop.dat before closing it.  

• Open IWREDSS, the interface should include the newly added crops
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Appendix 3. Calculation of daily ETo using temperature data. 

 
STEP 1: Extraterrestrial radiation (Ra) is calculated for each day using the following 
equations from Duffie and Beckman (1980) (reproduced from Snyder and Eching, 2002). 
 

 
 
STEP 2: Calculate ET using 1995 Hargreaves equation (Hargreaves and Samani, 1985) 
(reproduced from Snyder and Eching, 2002). 
 

 
 
Where: T

m 
= mean daily temperature in 

o
C, T

X
 = the maximum daily air temperature in 

o
C, and T

n
 = the minimum daily air temperature in 

o
C. 
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Appendix 4a. System boundaries and climate data stations for the Kekaha, Kauai 

and East Kauai systems. Stations information is in Table 3. The isohyets (dark 

contours) indicate gradients in rainfall, while the contours (light lines) indicate the 

elevation. 
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Appendix 4b. System boundaries and climate data stations for the Waiahole, Waimanalo 
and Molokai systems. Stations information is in Table 3. Isohyets (dark) indicate 
gradients in rainfall (dark). The contours (light) indicate the elevation.  
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Appendix 4c. System boundaries and climate data stations for the West Maui and Kula 
systems. Station information is in Table 3. Isohyets (dark) indicate gradients in rainfall. 
Elevation is indicated by the contours (light). 
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Appendix 4d. System boundaries and climate data stations for the Kamuela and Lower 
Hamakua systems. Stations information is in Table 3. Isohyets (dark) indicate gradients in 
rainfall. Elevation is indicated by the contours (light). 
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Appendix: 5a: Annual water budget components 
 

MO NIR GIR GAL_A G_RAIN N_RAIN ER ER21 RO INT ETo ET DR 
1 0.0 0.0 0.0 6.9 5.2 2.2 3.2 1.7 0.0 3.2 2.0 2.9 
2 0.0 0.0 1.1 4.3 3.6 1.7 2.0 0.7 0.0 3.3 2.0 1.8 
3 0.4 0.4 11.3 3.8 3.1 1.8 2.0 0.7 0.0 4.0 2.7 1.3 
4 0.8 0.9 25.3 3.2 2.7 2.2 2.0 0.4 0.1 4.2 3.5 0.5 
5 1.9 2.3 61.6 3.0 2.3 1.9 1.9 0.5 0.2 4.7 4.8 0.4 
6 3.3 3.8 104.0 1.4 1.1 1.1 1.1 0.1 0.2 4.6 5.4 0.0 
7 4.1 4.8 130.7 1.7 1.4 1.4 1.3 0.0 0.2 4.7 5.7 0.0 
8 4.3 5.1 138.8 1.5 1.2 1.2 1.1 0.1 0.2 4.7 5.6 0.0 
9 3.5 4.1 112.6 2.1 1.8 1.8 1.5 0.1 0.2 4.4 5.2 0.0 

10 2.5 2.9 79.0 3.6 2.8 2.7 2.3 0.6 0.2 3.9 4.3 0.1 
11 0.7 0.8 21.9 6.1 4.5 3.4 3.2 1.3 0.3 3.1 2.8 1.1 
12 0.1 0.2 4.5 5.0 3.9 2.6 2.6 0.9 0.2 2.9 2.1 1.3 

Total 21.6 25.4 690.7 42.5 33.5 24.0 24.1 7.2 1.8 47.5 46.2 9.5 
             
Seasonal (Jan-Apr) water budget components        
MO NIR GIR GAL_A G_RAIN N_RAIN ER ER21 RO INT ETo ET DR 

1 0.0 0.0 0.0 6.9 5.2 2.3 3.2 1.7 0.0 3.2 2.2 2.9 
2 0.3 0.4 9.9 4.3 3.4 2.1 2.4 0.7 0.1 3.3 3.4 1.3 
3 1.6 1.9 52.4 3.8 2.9 2.2 2.4 0.7 0.2 4.0 4.8 0.7 
4 1.1 1.3 35.5 3.2 2.6 2.4 2.1 0.4 0.2 4.2 3.6 0.2 

NIR 3.1 3.6 97.8 18.2 14.0 9.0 10.1 3.5 0.6 14.6 14.0 5.1 
             
Seasonal (Feb-May) water budget components        
MO NIR GIR GAL_A G_RAIN N_RAIN ER ER21 RO INT ETo ET DR 

2 0.1 0.1 1.9 4.3 3.5 1.9 2.0 0.7 0.0 3.3 2.1 1.7 
3 0.9 1.0 27.3 3.8 2.9 2.0 2.3 0.7 0.2 4.0 4.0 1.0 
4 1.8 2.1 57.9 3.2 2.6 2.3 2.2 0.4 0.2 4.2 5.0 0.3 
5 1.7 2.0 55.4 3.0 2.2 2.0 1.8 0.5 0.2 4.7 4.1 0.2 

NIR 4.5 5.2 142.5 14.3 11.3 8.2 8.3 2.4 0.6 16.1 15.2 3.1 
             
Seasonal (Mar-Jun) water budget components        
MO NIR GIR GAL_A G_RAIN N_RAIN ER ER21 RO INT ETo ET DR 

3 0.1 0.1 3.1 3.8 3.1 1.9 1.9 0.7 0.0 4.0 2.4 1.2 
4 1.0 1.2 32.4 3.2 2.6 2.1 2.1 0.4 0.2 4.2 4.3 0.5 
5 2.6 3.0 81.9 3.0 2.2 2.0 2.0 0.5 0.2 4.7 5.6 0.2 
6 2.4 2.8 75.7 1.4 1.1 1.1 1.0 0.1 0.2 4.6 3.9 0.0 

NIR 6.0 7.1 193.1 11.4 9.1 7.1 7.0 1.8 0.6 17.4 16.2 2.0 
             
Seasonal (Apr-Jul) water budget components        
MO NIR GIR GAL_A G_RAIN N_RAIN ER ER21 RO INT ETo ET DR 

4 0.1 0.1 3.7 3.2 2.8 2.0 1.8 0.4 0.0 4.2 2.6 0.8 
5 1.5 1.7 47.1 3.0 2.3 1.8 1.9 0.5 0.2 4.7 4.8 0.5 
6 3.2 3.8 102.1 1.4 1.1 1.1 1.1 0.1 0.2 4.6 5.5 0.0 
7 2.6 3.0 82.6 1.7 1.4 1.4 1.2 0.0 0.2 4.7 4.1 0.0 

NIR 7.4 8.7 235.5 9.3 7.6 6.3 5.9 1.1 0.6 18.1 17.0 1.3 
             

Seasonal (May-Aug) water budget components        
MO NIR GIR GAL_A G_RAIN N_RAIN ER ER21 RO INT ETo ET DR 

5 0.2 0.3 8.0 3.0 2.4 1.7 1.5 0.5 0.0 4.7 2.8 0.7 
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6 2.1 2.5 67.6 1.4 1.1 1.1 1.0 0.1 0.1 4.6 4.7 0.0 
7 3.4 4.0 109.5 1.7 1.4 1.4 1.3 0.0 0.2 4.7 5.7 0.0 
8 2.6 3.0 82.8 1.5 1.2 1.2 1.0 0.1 0.2 4.7 4.1 0.0 

NIR 8.4 9.9 267.8 7.6 6.2 5.4 4.8 0.8 0.6 18.7 17.2 0.8 
             
Seasonal (Jun-Sep) water budget components        
MO NIR GIR GAL_A G_RAIN N_RAIN ER ER21 RO INT ETo ET DR 

6 0.4 0.4 11.4 1.4 1.3 1.1 0.8 0.1 0.0 4.6 2.5 0.1 
7 2.1 2.4 65.9 1.7 1.5 1.5 1.2 0.0 0.2 4.7 4.8 0.0 
8 3.6 4.2 113.5 1.5 1.2 1.2 1.1 0.1 0.2 4.7 5.6 0.0 
9 2.3 2.7 72.0 2.1 1.8 1.8 1.4 0.1 0.2 4.4 3.8 0.0 

NIR 8.2 9.7 262.9 6.7 5.8 5.6 4.5 0.4 0.6 18.4 16.8 0.1 
             
Seasonal (Jul-Oct) water budget components        
MO NIR GIR GAL_A G_RAIN N_RAIN ER ER21 RO INT ETo ET DR 

7 0.3 0.3 9.3 1.7 1.6 1.6 1.0 0.0 0.0 4.7 2.8 0.1 
8 2.2 2.6 70.6 1.5 1.3 1.3 1.0 0.1 0.1 4.7 4.8 0.0 
9 2.9 3.4 93.3 2.1 1.8 1.8 1.5 0.1 0.2 4.4 5.2 0.0 

10 1.5 1.8 49.0 3.6 2.8 2.6 2.2 0.6 0.2 3.9 3.5 0.2 
NIR 7.0 8.2 222.1 8.9 7.5 7.2 5.7 0.8 0.6 17.6 16.4 0.3 
             
Seasonal (Aug-Nov) water budget components        
MO NIR GIR GAL_A G_RAIN N_RAIN ER ER21 RO INT ETo ET DR 

8 0.4 0.5 13.6 1.5 1.4 1.3 0.9 0.1 0.0 4.7 2.7 0.1 
9 1.6 1.9 52.4 2.1 1.8 1.8 1.4 0.1 0.1 4.4 4.5 0.0 

10 2.0 2.3 63.0 3.6 2.8 2.5 2.3 0.6 0.2 3.9 4.6 0.3 
11 0.5 0.6 16.0 6.1 4.5 3.3 3.2 1.3 0.3 3.1 2.8 1.2 

NIR 4.5 5.3 144.9 13.2 10.5 9.0 7.8 2.1 0.6 16.0 14.5 1.6 
             
Seasonal (Sep-Dec) water budget components        
MO NIR GIR GAL_A G_RAIN N_RAIN ER ER21 RO INT ETo ET DR 

9 0.2 0.2 5.5 2.1 2.0 1.8 1.2 0.1 0.0 4.4 2.6 0.2 
10 1.0 1.2 32.2 3.6 2.8 2.2 2.2 0.6 0.2 3.9 3.9 0.6 
11 0.7 0.8 23.0 6.1 4.5 3.2 3.4 1.3 0.3 3.1 3.7 1.3 
12 0.3 0.4 11.1 5.0 3.9 2.8 2.7 0.9 0.2 2.9 2.6 1.2 

NIR 2.2 2.6 71.7 16.8 13.2 10.0 9.5 2.8 0.7 14.2 12.8 3.3 
             
Seasonal (Oct-Jan) water budget components        
MO NIR GIR GAL_A G_RAIN N_RAIN ER ER21 RO INT ETo ET DR 
10 0.1 0.1 2.5 3.6 3.0 2.0 1.0 0.6 0.0 3.9 2.4 1.0 
11 0.3 0.3 8.2 6.1 4.6 2.6 1.5 1.3 0.2 3.1 3.2 2.0 
12 0.6 0.7 19.7 5.1 4.0 2.9 1.2 0.9 0.2 2.9 3.5 1.1 
1 0.1 0.2 4.8 6.6 4.7 2.7 3.0 1.7 0.2 3.0 2.7 2.0 

NIR 1.1 1.3 35.3 21.7 16.5 10.3 6.7 4.5 0.7 13.0 11.8 6.2 
             
Seasonal (Nov-Feb) water budget components        
MO NIR GIR GAL_A G_RAIN N_RAIN ER ER21 RO INT ETo ET DR 
11 0.0 0.0 0.0 6.1 4.8 2.1 1.5 1.3 0.0 3.1 2.1 2.7 
12 0.2 0.2 6.5 5.1 4.1 2.4 1.2 0.9 0.2 2.9 3.0 1.7 
1 0.4 0.4 11.7 6.8 4.9 3.1 3.0 1.7 0.3 3.1 3.8 1.8 
2 0.3 0.4 10.8 4.0 3.2 2.2 2.0 0.6 0.2 3.2 2.8 1.0 

NIR 0.9 1.1 29.1 22.4 17.1 9.9 7.7 4.7 0.7 12.4 11.7 7.2 
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Seasonal (Dec-Mar) water budget components        
MO NIR GIR GAL_A G_RAIN N_RAIN ER ER21 RO INT ETo ET DR 
12 0.0 0.0 0.7 5.1 4.2 2.0 1.2 0.9 0.0 2.9 1.9 2.3 
1 0.2 0.2 5.9 6.8 4.9 2.6 3.0 1.7 0.2 3.1 3.3 2.3 
2 0.7 0.8 22.8 4.4 3.4 2.5 2.0 0.7 0.2 3.3 4.0 0.9 
3 1.0 1.2 31.3 3.8 2.8 2.0 1.9 0.7 0.2 3.9 3.5 0.8 

NIR 1.9 2.2 60.6 20.2 15.5 9.3 8.1 4.0 0.6 13.3 12.8 6.3 
 

Appendix 5b: Statistics for annual and seasonal net irrigation requirements 
MO MEAN MED. CV XMAX XMIN ZERO RSQ 50% 80% 90% 95% 
Jan 0.0 0.0 0.0 0.0 0.0 0.0 1.0 0.0 0.0 0.0 0.0 
Feb 0.0 0.0 3.7 0.6 0.0 0.0 0.0 0.0 0.0 0.0 0.0 
Mar 0.4 0.0 1.3 2.0 0.0 0.0 0.8 0.4 0.9 1.2 1.5 
Apr 0.9 0.7 1.0 2.5 0.0 0.0 0.8 0.8 1.8 2.4 3.1 
May 2.3 2.6 0.5 3.6 0.0 0.0 0.9 2.1 3.4 4.1 4.7 
Jun 3.8 3.9 0.3 5.9 0.9 0.0 1.0 3.8 5.0 5.5 6.0 
Jul 4.8 4.9 0.2 6.3 2.8 0.0 0.9 4.9 5.7 6.2 6.5 
Aug 5.1 5.2 0.2 7.1 2.9 0.0 0.9 5.2 6.1 6.6 6.6 
Sep 4.1 3.9 0.3 6.1 1.9 0.0 0.9 4.2 5.0 5.4 5.7 
Oct 2.9 2.6 0.5 4.9 0.9 0.0 0.9 2.7 4.2 5.0 5.0 
Nov 0.8 0.0 1.2 2.5 0.0 0.0 0.8 0.9 1.7 2.2 2.6 
Dec 0.2 0.0 2.5 1.2 0.0 0.0 0.8 1.1 1.2 1.2 1.2 
Total 25.4 25.6 0.2 35.4 16.2 0.0 1.0 25.6 30.2 32.5 34.2 
NIR 21.6 21.8 0.2 30.1 13.8 0.0 1.0 21.8 25.7 27.6 29.1 
            
Statistics for annual and seasonal net irrigation requirements      
MO MEAN MED. CV XMAX XMIN ZERO RSQ 50% 80% 90% 95% 
Jan 0.0 0.0 0.0 0.0 0.0 0.0 1.0 0.0 0.0 0.0 0.0 
Feb 0.4 0.0 1.4 1.7 0.0 0.0 0.5 0.6 0.9 1.1 1.2 
Mar 1.9 1.9 0.7 5.0 0.0 0.0 0.9 1.7 3.2 4.1 5.0 
Apr 1.3 1.2 0.8 2.6 0.0 0.0 0.7 1.5 2.3 2.7 3.1 
Total 3.6 3.5 0.7 9.2 0.0 0.0 0.9 3.1 6.0 8.0 9.9 
NIR 3.1 2.9 0.7 7.8 0.0 0.0 0.9 2.6 5.1 6.8 8.4 
            
Statistics for annual and seasonal net irrigation requirements      
MO MEAN MED. CV XMAX XMIN ZERO RSQ 50% 80% 90% 95% 
Feb 0.1 0.0 3.0 0.7 0.0 0.0 0.0 0.0 0.0 0.0 0.0 
Mar 1.0 0.9 0.9 2.7 0.0 0.0 0.8 0.9 1.7 2.1 2.6 
Apr 2.1 1.9 0.6 4.0 0.0 0.0 0.9 1.9 3.3 4.1 4.8 
May 2.0 2.4 0.6 3.8 0.0 0.0 0.9 2.0 3.0 3.6 4.1 
Total 5.2 5.2 0.5 10.8 0.9 0.0 1.0 5.0 7.6 9.2 10.5 
NIR 4.5 4.4 0.5 9.1 0.8 0.0 1.0 4.2 6.5 7.8 8.9 
            
Statistics for annual and seasonal net irrigation requirements      
MO MEAN MED. CV XMAX XMIN ZERO RSQ 50% 80% 90% 95% 
Mar 0.1 0.0 2.2 0.7 0.0 0.0 0.8 0.5 0.6 0.7 0.7 
Apr 1.2 0.9 0.8 2.8 0.0 0.0 0.8 1.1 2.0 2.5 3.1 
May 3.0 2.9 0.5 4.9 0.0 0.0 0.9 2.9 4.3 5.2 5.8 
Jun 2.8 2.5 0.4 3.9 0.0 0.0 0.8 2.9 3.7 4.0 4.4 
Total 7.1 6.5 0.4 11.0 2.9 0.0 1.0 7.0 9.5 10.7 11.8 
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NIR 6.0 5.5 0.4 9.4 2.5 0.0 1.0 6.0 8.0 9.1 10.0 
            
Statistics for annual and seasonal net irrigation requirements      
MO MEAN MED. CV XMAX XMIN ZERO RSQ 50% 80% 90% 95% 
Apr 0.1 0.0 2.0 0.7 0.0 0.0 1.0 0.6 0.6 0.7 0.7 
May 1.7 1.8 0.5 3.4 0.0 0.0 0.9 1.6 2.5 3.0 3.4 
Jun 3.8 3.9 0.3 5.8 0.9 0.0 0.9 3.8 4.9 5.5 5.9 
Jul 3.0 2.6 0.3 4.8 1.2 0.0 0.8 3.1 3.7 3.9 4.2 
Total 8.7 9.1 0.3 12.2 4.3 0.0 1.0 8.7 10.8 11.8 12.6 
NIR 7.4 7.7 0.3 10.4 3.6 0.0 1.0 7.4 9.2 10.0 10.7 
            
Statistics for annual and seasonal net irrigation requirements      
MO MEAN MED. CV XMAX XMIN ZERO RSQ 50% 80% 90% 95% 
May 0.3 0.0 1.1 0.7 0.0 0.0 0.9 0.6 0.7 0.7 0.7 
Jun 2.5 2.6 0.4 4.4 0.9 0.0 0.9 2.4 3.4 3.9 4.3 
Jul 4.0 3.9 0.2 5.8 1.9 0.0 0.9 4.1 4.8 5.2 5.5 
Aug 3.0 2.6 0.3 5.1 1.2 0.0 0.9 3.0 3.9 4.4 4.8 
Total 9.9 9.9 0.2 14.8 5.0 0.0 1.0 10.0 12.0 12.9 13.7 
NIR 8.4 8.5 0.2 12.6 4.3 0.0 1.0 8.5 10.2 11.0 11.6 
            
Statistics for annual and seasonal net irrigation requirements      
MO MEAN MED. CV XMAX XMIN ZERO RSQ 50% 80% 90% 95% 
Jun 0.4 0.6 0.7 0.7 0.0 0.0 1.0 0.6 0.7 0.7 0.7 
Jul 2.4 2.7 0.4 3.6 0.9 0.0 0.9 2.4 3.3 3.8 4.2 
Aug 4.2 3.9 0.3 5.9 1.9 0.0 0.9 4.2 5.1 5.6 5.9 
Sep 2.7 2.5 0.3 4.9 1.2 0.0 0.8 2.6 3.4 3.7 4.0 
Total 9.7 9.8 0.2 14.8 4.9 0.0 1.0 9.8 11.8 12.7 13.5 
NIR 8.2 8.3 0.2 12.6 4.2 0.0 1.0 8.3 10.0 10.8 11.5 
            
Statistics for annual and seasonal net irrigation requirements      
MO MEAN MED. CV XMAX XMIN ZERO RSQ 50% 80% 90% 95% 
Jul 0.3 0.0 1.1 1.3 0.0 0.0 0.6 0.5 0.7 0.8 0.9 
Aug 2.6 2.7 0.4 4.5 0.9 0.0 0.9 2.5 3.7 4.4 5.0 
Sep 3.4 3.0 0.3 5.0 1.9 0.0 0.9 3.4 4.4 4.8 5.2 
Oct 1.8 1.3 0.6 3.6 0.0 0.0 0.9 1.8 2.7 3.2 3.7 
Total 8.2 8.0 0.3 13.7 3.9 0.0 1.0 8.2 10.5 11.6 12.6 
NIR 7.0 6.8 0.3 11.6 3.3 0.0 1.0 6.9 8.9 9.9 10.7 
            
Statistics for annual and seasonal net irrigation requirements      
MO MEAN MED. CV XMAX XMIN ZERO RSQ 50% 80% 90% 95% 
Aug 0.5 0.6 0.8 1.3 0.0 0.0 0.6 0.6 0.8 0.9 1.0 
Sep 1.9 1.8 0.5 3.6 0.0 0.0 0.9 1.9 2.8 3.3 3.8 
Oct 2.3 2.8 0.5 4.0 0.0 0.0 0.9 2.3 3.3 3.9 4.4 
Nov 0.6 0.0 1.2 2.5 0.0 0.0 0.4 0.0 0.0 0.0 0.0 
Total 5.3 5.5 0.4 9.2 1.8 0.0 1.0 5.2 7.4 8.5 9.5 
NIR 4.5 4.6 0.4 7.8 1.6 0.0 1.0 4.4 6.3 7.2 8.1 
            
Statistics for annual and seasonal net irrigation requirements      
MO MEAN MED. CV XMAX XMIN ZERO RSQ 50% 80% 90% 95% 
Sep 0.2 0.0 1.5 0.7 0.0 0.0 1.0 0.5 0.6 0.7 0.7 
Oct 1.2 0.9 0.9 3.4 0.0 0.0 0.9 1.1 2.1 2.7 3.3 
Nov 0.8 0.0 1.3 2.9 0.0 0.0 0.8 0.8 1.8 2.6 3.3 
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Dec 0.4 0.0 1.4 1.3 0.0 0.0 0.9 1.1 1.2 1.2 1.2 
Total 2.6 2.5 0.7 5.8 0.0 0.0 1.0 2.3 4.4 5.7 7.0 
NIR 2.2 2.1 0.7 4.9 0.0 0.0 1.0 1.9 3.7 4.9 6.0 
            
Statistics for annual and seasonal net irrigation requirements      
MO MEAN MED. CV XMAX XMIN ZERO RSQ 50% 80% 90% 95% 
Oct 0.1 0.0 2.5 0.7 0.0 0.0 0.9 0.5 0.6 0.6 0.7 
Nov 0.3 0.0 1.8 1.7 0.0 0.0 0.8 0.3 0.8 1.2 1.5 
Dec 0.7 0.9 1.1 2.8 0.0 0.0 0.8 0.7 1.4 1.8 2.1 
Jan 0.2 0.0 2.5 1.3 0.0 0.0 1.0 1.1 1.2 1.2 1.3 
Total 1.3 0.9 1.0 4.9 0.0 0.0 0.9 1.1 2.2 3.0 3.7 
NIR 1.1 0.8 1.0 4.1 0.0 0.0 0.9 0.9 1.8 2.5 3.1 
            
Statistics for annual and seasonal net irrigation requirements      
MO MEAN MED. CV XMAX XMIN ZERO RSQ 50% 80% 90% 95% 
Nov 0.0 0.0 0.0 0.0 0.0 0.0 1.0 0.0 0.0 0.0 0.0 
Dec 0.2 0.0 1.6 0.9 0.0 0.0 0.7 0.7 0.8 0.9 0.9 
Jan 0.4 0.0 1.4 1.9 0.0 0.0 0.7 0.6 1.0 1.3 1.5 
Feb 0.4 0.0 1.9 2.5 0.0 0.0 0.8 0.4 1.1 1.7 2.2 
Total 1.1 0.9 1.1 4.3 0.0 0.0 1.0 0.9 2.1 3.0 3.8 
NIR 0.9 0.8 1.1 3.6 0.0 0.0 1.0 0.8 1.8 2.5 3.3 
            
Statistics for annual and seasonal net irrigation requirements      
MO MEAN MED. CV XMAX XMIN ZERO RSQ 50% 80% 90% 95% 
Dec 0.0 0.0 5.3 0.7 0.0 0.0 0.0 0.0 0.0 0.0 0.0 
Jan 0.2 0.0 1.8 0.9 0.0 0.0 0.8 0.7 0.8 0.9 0.9 
Feb 0.8 0.9 1.1 3.0 0.0 0.0 0.8 0.8 1.5 2.0 2.5 
Mar 1.2 1.1 1.1 3.7 0.0 0.0 0.8 1.3 2.3 3.0 3.5 
Total 2.2 2.0 0.9 7.6 0.0 0.0 0.9 1.7 4.0 5.8 7.7 
NIR 1.9 1.7 0.9 6.4 0.0 0.0 0.9 1.4 3.4 4.9 6.5 
 

 


